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Completing the General Information


Renaming the Spreadsheet Tabs
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Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.
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-


-
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Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission
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Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP







OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA


                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


1 2016


Agency Contact:
Andrew Tobin, 
Deputy Director


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Charles Walthall
Invited Speaker-
International Cotton Trade 
Event (ICA)


10/30/2015 San Francisco, CA         Airfare                      X $588.20 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


National Program 
Leader, ONP, NRSAS


The International Cotton 
Association Ltd. 10/31/2015 10/28/2015-


10/31/2015                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Jill Schroeder
Invited speaker-
Entomological Society of 
America Annual Meeting


11/15/2015 Minneapolis, MN Conference 
Registration X $300.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


MISC travel 
expenses X $400.00 


Agronomist/Weed 
Scientist, ARS OPMP


Entomological Society of 
America 11/18/2015 11/16/2015-


11/17/2015                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Jill Schroeder


Invited 
Speaker,ADVANCE 
Distinguished Lecture 
Series


12/1/2015 Manhattan, KS Airfare X $356.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Hotel X $200.00 


BENEFIT SOURCE


The International Cotton 
Association Ltd.


BENEFIT SOURCE


Entomological Society of 
America


BENEFIT SOURCE


Kansas State University


BENEFIT SOURCE


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


tobin.andrew@oe.usda.gov


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


Asia Pacific Forum 
Pacific Rim Foundation 


3


LOCATION


TRAVEL DATE(S)


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


U.S. Department of Agriculture
Agricultural Research Service, HQ Program Offices & NAL NEGATIVE 


REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X


REPORTING 
PERIOD: 


OCTOBER 1, 
2015- MARCH 


31, 2016


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2016







 


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


Agronomist/Weed 
Scientist, ARS OPMP


Kansas State University, 
College of Agriculture, 
Dept of Agronomy


12/3/2015 12/1/2015-12/3/2015 Meals X $175.00 
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Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission
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Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
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                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


1 2 2016


Agency Contact:
Andrew Tobin, 
Deputy Director


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Brian J. Kerr International Conference 
on Feed Efficiency in 10/21/2015 Omaha, NE Lodging/Registrati


on X $304


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Animal 
Scientist


Iowa State University and 
Kansas State University 10/22/2015 10/20-21/2015                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Kenneth A. Sudduth


Precision agriculture: A 
novel technology for 
sustainable management 
of agriculture in the third 
millennium conference


10/19/2015 Milan, Italy CC/ Lodging/Reg 
Fee/Meals X $8,470


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Agricultural Engineer ISAFOM UOS Catania 10/19/2015 10/17-22/2015                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Shelley Jansky Reinventing Potato 
workshop 10/6/2015 Watsonville, CA


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Taxi X 40


Research Geneticist 
Plants


Driscoll’s Corporate 
Campus 10/6/2015 10/5-7/2015 CC/ Lodging/ Per 


diem X 852.4


BENEFIT SOURCE


Iowa State University


BENEFIT SOURCE


ISAFOM UOS Cantania


BENEFIT SOURCE


Driscoll's Corporate 
Campus


BENEFIT SOURCE


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


tobin.andrew@oe.usda.gov


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


Asia Pacific Forum 
Pacific Rim Foundation 


3


LOCATION


TRAVEL DATE(S)


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


USDA
Agricultural Research Service - Midwest Area NEGATIVE 


REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X


REPORTING 
PERIOD: 


OCTOBER 1, 
2015- MARCH 


31, 2016


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2016







Agency Contact: Kit Mernick


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


J. Mark Powell MSU Seminar Series 1/15/2016 Hickory Corners, MI


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


J. Mark Powell Michigan State University 1/15/2016 01/14-15/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Daniel C. Olk GrowMate Annual 
Conference 1/27/2016 Houston, TX


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Soil Scientist GrowMate International 1/29/2016 01/26-30/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


David Grant Plant & Animal Genome 
XXIV 1/9/2016 San Diego, CA


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Geneticist Scherago International 1/13/2016 01/08-14/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Heather Allen
Microbiology and 
Molecular Genetics 
Seminar Series


1/25/2016 East Lansing, MI


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Microbiologist Michigan State University 1/27/2013 01/25-27/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Stephen B. Goodwin Plant & Animal Genome 
XXIV 1/9/2016 San Diego, CA


REPORTING 
PERIOD: 


OCTOBER 1, 
2015- MARCH 


31, 2016


Agricultural Research Service - Midwest Area
kit.mernick@ars.usda.gov


1353 Travel Report for USDA, ARS - MWA for the reporting period OCTOBER 1, 20    


No.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SO
This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when t         
For definitions and policies  see 41 CFR part 304-1


USDA
X


EX


LOCATION BENEFIT SOURCE


Asia Pacific Forum 
Pacific Rim Foundation 


TRAVEL DATE(S)


TRAVELER EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
BENEFIT SOURCE


2


LOCATION BENEFIT SOURCE


GrowMate International 
LLC


TRAVEL DATE(S)


1


LOCATION BENEFIT SOURCE


Michigan State University 
Hickory Corners, MI


TRAVEL DATE(S)


4


LOCATION BENEFIT SOURCE
Michigan State University 


Department of 
Microbiology and 


Molecular Genetics
TRAVEL DATE(S)


3


LOCATION BENEFIT SOURCE


Scherago International


TRAVEL DATE(S)


5


LOCATION BENEFIT SOURCE


Scherago International







TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Plant 
Pathologist Scherago International 1/13/2016 01/08-12/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Kevin King Great Lakes Crop Summit 1/27/2016 Mount Pleasant, MI


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Agricultural Engineer


Tera Harvard, Executive 
Assistant, Corn Marketing 
Program of Michigan; 
Michigan Corn Growers 
Association


1/28/2016 01/26-28/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Douglas L. Karlen
NCR-SARE 
Administrative Council 
meeting


2/10/2016 Minneapolis, MN


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Soil Scientist University of 
Minnesota/NCR-SARE 2/11/2016 02/10-13/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Richard Leo Hellmich II Resistant Cowpea Annual 
Review and Planning 2/16/2016 Accra, Ghana


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Entomologist


Pod Borer Resistant 
Cowpea Project, African 
Agricultural Technology 
Foundation


2/17/2016 02/14-18/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Richard Leo Hellmich II
56 Annual Meeting of the 
Weed Science Society of 
America 


2/8/2016 San Juan, Puerto 
Rico


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Entomologist Weed Science Society of 
America 2/11/2016 02/09-11/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Bruce Hibbard
2016 Annual Monsanto 
Corn Academic Summit 
meeting


2/10/2016 Saint Louis, MO


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Entomologist Monsanto 2/10/2016 2/10-12/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Lisa Meihls
2016 Annual Monsanto 
Corn Academic Summit 
meeting


2/10/2016 Saint Louis, MO


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


6


LOCATION BENEFIT SOURCE


Michigan Corn Growers 
Association


TRAVEL DATE(S)


5
TRAVEL DATE(S)


8


LOCATION BENEFIT SOURCE
Pod Borer Resistant 


Cowpea Project, African 
TRAVEL DATE(S)


7


LOCATION BENEFIT SOURCE


North Central Region 
Sustainable Agriculture 
Research & Education


TRAVEL DATE(S)


10


LOCATION BENEFIT SOURCE


Monsanto


TRAVEL DATE(S)


9


LOCATION BENEFIT SOURCE


Weed Science Society of 
America


TRAVEL DATE(S)


11


LOCATION BENEFIT SOURCE


Monsanto


TRAVEL DATE(S)







Research Entomologist monsanto 2/12/2016 2/10-12/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Margaret Redinbaugh Present research/ meet 
with collaborators 2/13/2016


Tanzania-Dar es 
Salaam, Arusha, 
Monogoro 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


RES MOLECULAR 
PLANT BIOLGST The Ohio State University 2/20/2016 02/07-20/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Candice Gardner


International Maize 
Genetic Resources 
Advisory Committee 
meeting


2/16/2016 Texococo, Mexico


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Supervisory Plant 
Biologist


International Center for 
Maize and Wheat 2/18/2016 02/15-19/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Thomas A. Coudron Monsanto Corn Academic 
Summit 2/10/2016 Chesterfield, MO


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Chemist Monsanto Company 2/12/2016 2/10-12/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Douglas L. Karlen
Building Consensus on 
Soil Health Indicator 
Methods meeting


2/22/2016 Ardmore, OK


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Soil Scientist Noble Foundation and 
Farm Foundation 2/24/2016 02/21-25/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Kenneth F. Kalscheur


Creating the Future 
Workforce in Food, 
Agriculture, and Natural 
Resources meeting


2/10/2016 Washington, DC


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Animal 
Scientist


The National Academies 
of Sciences  Engineering  2/11/2016 02/09-12/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Kelly M. Lager Unified Research Review 2/15/2016 Des Moines, IA


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Supervisory Research 
Veterinary Medical National Pork Board 2/17/2016 02/15-17/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


12


LOCATION BENEFIT SOURCE


The Ohio State University


TRAVEL DATE(S)


14


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


13


LOCATION BENEFIT SOURCE


Internationl Center for 
Maize and Wheat 


Improvement


TRAVEL DATE(S)


16


LOCATION BENEFIT SOURCE


Noble Foundation


TRAVEL DATE(S)


15


LOCATION BENEFIT SOURCE


Monsanto


TRAVEL DATE(S)


18


LOCATION BENEFIT SOURCE


National Pork Board


TRAVEL DATE(S)


17


LOCATION BENEFIT SOURCE


American Dairy Science 
Association


TRAVEL DATE(S)


LOCATION BENEFIT SOURCE







TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Daniel C. Olk
Meeting/Discussion with 
Platinum Star IP Partners 
and its collaborators


2/24/2016 Albuquerque, New 
Mexico


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Soil Scientist Platinum Star IP Partners 2/25/2016 02/24-25/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Elijah Talamas


Speaking engagement on 
Identification of species of 
Trissolcus in the 
Canadian National 
Collection of Insects


2/15/2016 Ottawa, CANADA


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Entomologist CanaColl Foundation 2/26/2016 02/14-27/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Brad Coates Corn Academic Summit 2/10/2016 St. Charles, MO


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Geneticist Monsanto 2/12/2016 02/10-12/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Eduardo Casa Seminar Presentation 2/7/2016 San Carlos, Costa 
Rica


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Supervisory Research 
Animal Scientist


Technological Institute of 
Costa Rica 2/13/2016 02/06-13/2016


20


LOCATION BENEFIT SOURCE


Platinum Star IP Partners


TRAVEL DATE(S)


19
TRAVEL DATE(S)


22


LOCATION BENEFIT SOURCE


CanaColl Foundation


TRAVEL DATE(S)


21


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


24


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


23


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


26


LOCATION BENEFIT SOURCE


Technological Institute of 
Costa Rica


TRAVEL DATE(S)


25


LOCATION BENEFIT SOURCE


The Monsanto Company


TRAVEL DATE(S)







TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Kelly M. Lager


International Symposium 
on Development of 
Effective Porcine 
Epidemic Diarrhea (PED) 
and Transmissible 
Gastroenteritis (TGE) 
Vaccine


2/26/2016 Akita City, JAPAN


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Supervisory Research 
Veterinary Medical 
Officer


Japanese Society of Farm 
Animal Veterinary 
Medicine


2/27/2016 02/22-28/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Frank Forcella Lecture 2/23/2016 Seville, SPAIN


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Agronomist University of Seville 2/25/2016 02/21-26/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


28


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


27


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


30


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


29


LOCATION BENEFIT SOURCE


Japanese Society of 
Farm Animal Veterinary 


Medicine


TRAVEL DATE(S)


32


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


31


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


34


LOCATION BENEFIT SOURCE


University of Seville


TRAVEL DATE(S)


33


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


LOCATION BENEFIT SOURCE







Donald C. Weber
Northeast SARE Winter 
Administrative Council 
Meeting


2/9/2016 Burlington, VT


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Entomologist USDA NIFA 2/11/2016 02/09-11/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Jason Mottern


Speaking engagement on 
Identification of species of 
Aphelinidae and 
Encyrtidae in the 
Canadian national 
Collection of Insects


2/15/2016 Ottawa, CANADA


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Entomologist CanaColl Foundation 2/26/2016 02/14-27/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Sang Yeo Kim
Crop Bioengineering 
Consortium Winter 
Meeting


2/26/2016 Ames, Iowa


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Plant 
Physiologist Iowa State University 2/27/2016 02/25-27/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Sang Yeol Kim
Crop Bioengineering 
Consortium Winter 
Meeting


2/26/2016 Ames, IA


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Plant 
Physiologist Iowa State University 2/27/2016 2/25-27/16


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Marcus E. Kehrli, Jr. Meeting with Elanco Dairy 
Business Unit 3/22/2016 Brussels, Belgium


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


NADC, Director Elanco Animal Health 3/22/2016 3/20-23/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Brink, Geoffrey E. MOSES Conference 2/25/2016 La Crosse, Wisconsin


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Agronomist
Midwest Organic 
Sustainable Education 
Service


2/27/2016 02/25-27/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Kristen Veum Soil Health Indicator 
Workshop 2/22/2016 Ardmore, OK


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


36


LOCATION BENEFIT SOURCE


CanaColl Foundation


TRAVEL DATE(S)


35
University of Vermont


TRAVEL DATE(S)


38


LOCATION BENEFIT SOURCE


Crop  Bioengineering 
Consortium Winter 


Meeting


TRAVEL DATE(S)


37


LOCATION BENEFIT SOURCE


Crop Bioengineering 
Consortium


TRAVEL DATE(S)


40


LOCATION BENEFIT SOURCE
Midwest Organic and 


Sustainable Education 
Service


TRAVEL DATE(S)


39


LOCATION BENEFIT SOURCE


Elanco Animal Health


TRAVEL DATE(S)


41


LOCATION BENEFIT SOURCE


Samuel Roberts Noble 
Foudation


TRAVEL DATE(S)







Research Soil Scientist USDA-NCRS 2/24/2016 02/22-24/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Hall, Mary Beth Dairy Focus 2016 3/30/2016 Halifax, Nova Scotia, 
CANADA


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Animal 
Scientist (Dairy)


Dairy Farmers of Nova 
Scotia and Perennia 3/31/2016 03/29-04/01/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Juan E. Zalapa
Latino Attainment: 
Meeting America’s Equity 
& Talent Imperatives


3/9/2016 Costa Mesa, CA


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Geneticist, Plants
American Association of 
Hispanics in Higher 
Education Inc


3/12/2016 03/09-12/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Ivan Baxter
2016 Corn Breeding 
Research & Maize 
Genetics meeting


3/16/2016 Jacksonville, FL


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research 
Computational Biologist


Donald Danforth  Plant 
Science Center 3/20/2016 03/15-20/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Ivan Baxter
Genomic Sciences 
Program Annual PI 
Meeting 2016


3/8/2016 Tysons, Virginia


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research 
Computational Biologist


Donald Danforth  Plant 
Science Center 3/9/2016 03/8-9/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Donald R Ort Breaking Yield Barriers of 
Crop Plants meeting 3/28/2016 Ein Gedi, Israel


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Plant 
Physiologist


Nature Genetics and the 
European Research 4/1/2016 3/26-4/2/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Wayne K. Coblentz (Virginia) Area Dairy 
Conference 2016 3/7/2016


Amelia, Culpeper, 
Harrisonburg, Marion 
and Rocky Mount, 
Virginia


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Leader Virginia Tech-Department 
of Dairy Science, 3/11/2016 3/6-14/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


42


LOCATION BENEFIT SOURCE


Dairy Farmers of Nova 
Scotia


TRAVEL DATE(S)


44


LOCATION BENEFIT SOURCE


Donald Danforth Plant 
Science Center


TRAVEL DATE(S)


43


LOCATION BENEFIT SOURCE


American Association of 
Hispanics in Higher 


Education, Inc.


TRAVEL DATE(S)


46


LOCATION BENEFIT SOURCE


The Hebrew University of 
Jerusalem


TRAVEL DATE(S)


45


LOCATION BENEFIT SOURCE


Donald Danforth Plant 
Science Center


TRAVEL DATE(S)


LOCATION BENEFIT SOURCE


47


LOCATION BENEFIT SOURCE


Virginia Tech-  
Department of Dairy 


Science


TRAVEL DATE(S)







Chi-Hua Huang
Soil Erosion and Water 
Quality Research 
Techniques - Workshop


3/14/2016
Utsunomiya 
University, 
Utsunomiya, JAPAN


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Res Soil Scntst Utsunomiya Univeristy 3/17/2016 3/12-17/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Gordon W. Selling
Cellulose and Renewable 
Materials Division 
Strategic Planning Retreat


3/11/2016 San Diego,CA


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Chemist Dr. Sheila M. Murphy, 
Chair 3/12/2016 3/11-16/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Jeffrey Carstens
Tri-State Forest 
Stewardship Conference 
2016


3/12/2016 Sinsinawa, WI


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Horticulturist Iowa State University 
Forestry Extension 3/12/2016 3/11-12/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Doug Allen
University of Minnesota 
BTI's Spring 2016 
Seminar Series


3/24/2016 St. Paul, MN


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Res Computational 
Biologist University of Minnesota 3/24/2016 3/23-25/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Heather Allen


The University of Iowa, 
Department of 
Microbiology Speaker 
Series


3/22/2016 Iowa City, IA


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Microbiologist The University of Iowa 3/22/2016 3/21-22/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


NELSON, RANDALL L. USAID funded Soybean 
Innovation Laboratory 3/29/2016


Lilongwe, Malawi; 
Chimoio, 
Mozambique, Lusaka, 
Zambia


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


SUPVY RES GENET 
PLANTS


UNIVERSITY OF 
ILLINOIS 4/7/2016 3/26-4/8/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Heathcliffe Riday
North East Pasture 
Consortium 2016 
Conference


3/16/2016 Freeport, ME


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


48
Utsunomiya University


TRAVEL DATE(S)


50


LOCATION BENEFIT SOURCE


Iowa State University 
Forestry Extension


TRAVEL DATE(S)


49


LOCATION BENEFIT SOURCE


Cellulose and Renewable 
Materials Division (CELL)


TRAVEL DATE(S)


52


LOCATION BENEFIT SOURCE


The University of Iowa


TRAVEL DATE(S)


51


LOCATION BENEFIT SOURCE


University of Minnesota


TRAVEL DATE(S)


54


LOCATION BENEFIT SOURCE
North East Pasture 


Consortium and 
University of Vermont 


Extension
TRAVEL DATE(S)


53


LOCATION BENEFIT SOURCE


University of Illinois


TRAVEL DATE(S)







Research Geneticist
North East Pasture 
Consortium and University 
of Vermont Extension


3/17/2016 3/15-18/16


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Dan B Jaynes


Workshop on the use of 
established research sites 
with capacity to measure 
drainage losses of N and 
P to investigate impacts of 
4R Nutrients


3/3/2016 Denver, CO


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Soil Scientist International Plant 
Nutrition Institute 3/4/2016 3/2-4/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Dana Dinnes Great Plains Agronomics 
2016 Annual Meetings 3/10/2016 Fargo, North Dakota


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Agronomist/Support 
Scientist


Great Plains Agronomics, 
LLC 3/10/2016 3/9-11/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Marcus E. Kehrli, Jr. Meeting with Elanco Dairy 
Business Unit 3/22/2016 Brussels, Belgium


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


NADC, Director Elanco Animal Health 3/22/2016 3/30-23/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Les J. Szabo National Plant Diagnostic 
Network (NPDN) Meeting 3/8/2016 Arlington, VA


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Geneticist National Plant Diagnostic 
Network (NPDN) 3/12/2016 3/9-11/16


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Matt Yost Meeting on Use of 
Established Long-Term 3/2/2016 Denver, Colorado 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Soil Scientist International Plant 
Nutrition Institute 3/3/2016 3/2-3/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Stephen B. Goodwin JGI Fungal Advisory 
Committee meeting 3/21/2016 Walnut Creek, CA


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Plant 
Pathologist


Berkeley Laboratories 
(funded by the Joint 3/22/2016 3/20-23/2016


56


LOCATION BENEFIT SOURCE


Great Plains Agronomics, 
LLC


TRAVEL DATE(S)


55


LOCATION BENEFIT SOURCE


International Plant 
Nutrition Institute


TRAVEL DATE(S)


58


LOCATION BENEFIT SOURCE


University of Florida, 
Office of Conferences 


and Institutes


TRAVEL DATE(S)


57


LOCATION BENEFIT SOURCE


Elanco Animal Health


TRAVEL DATE(S)


60


LOCATION BENEFIT SOURCE
Berkeley Laboratories 
(funded by the Joint 


Genome Institute of the 
U S  Department of 


TRAVEL DATE(S)


59


LOCATION BENEFIT SOURCE
International Plant 
Nutrition Institute


TRAVEL DATE(S)







TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Jerry Hatfield
Joint Seminar Series 
sponsored by Department 
of Horticulture


3/31/2016 East Lansing, MI


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Laboratory Director
Department of 
Horticulture, Michigan 
State University 


3/31/2016 3/30-4/1/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Carl Bolster Tobacco Barn Meeting 3/29/2016 Lexington, KY


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Hydrologist
University of Kentucky, 
Department of Plant and 
Soil Sciences


3/30/2016 3/28-30/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Steven F. Vaughn
The Mirimichi Green 
Education and Roundtable 
Session


3/16/2016 Rockville, MD


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Plant 
Physiologist Mr. John Haley 3/16/2016 3/15-17/2016


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Russell Gesch


Crop Pest Management 
Short Course and 
Minnesota Crop 
Production Retailers 
Trade Show 2015


12/8/2015 Minneapolis, MN


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Plant 
Physiologist University of Minnesota 12/10/2015 12/09-10/2015


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Harold Corby Kistler CRADA cooperator 
reporting meeting 11/4/2015 Triangle Park, NC


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Geneticist BASF (not an acronym) 11/4/2015 11/03-05/2015


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Torey Looft
Conference of Research 
Workers in Animal 
Diseases


12/7/2015 Chicago, IL


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Microbiologist


Mini conference at the 
Conference of Research 
Workers in Animal 
Diseases.


12/7/2015 12/06-08/2015


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Amy L. Vincent OFFLU Swine Influenza 
Group Meeting 12/3/2015 Paris, FRANCE


62


LOCATION BENEFIT SOURCE
University of Kentucky, 


Department of Plant and 
TRAVEL DATE(S)


61


LOCATION BENEFIT SOURCE


Michigan State University


TRAVEL DATE(S)


64


LOCATION BENEFIT SOURCE


University of Minnesota


TRAVEL DATE(S)


63


LOCATION BENEFIT SOURCE


Haley Sustainable Green 
Agronomics


TRAVEL DATE(S)


66


LOCATION BENEFIT SOURCE


Ohio State University


TRAVEL DATE(S)


65


LOCATION BENEFIT SOURCE


BASF (not an acronym)


TRAVEL DATE(S)


67


LOCATION BENEFIT SOURCE


World Organisation for 
Animal Health OIE







TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Veterinary 
Medical Officer


 World Organisation for 
Animal Health-OIE 12/4/2015 12/02-05/2015


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Amy L. Vincent Summit on Animals, 
Public Health and Ethics, 12/19/2015 Baltimore, MD


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Veterinary 
Medical Officer Johns Hopkins University, 12/10/2015 12/09-10/2015


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


68


LOCATION BENEFIT SOURCE


John Hopkins University


TRAVEL DATE(S)


TRAVEL DATE(S)


70


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


69


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


72


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


71


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


74


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


73


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


LOCATION BENEFIT SOURCE


75


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)







TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


76
TRAVEL DATE(S)


78


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


77


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


80


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


79


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


82


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


81


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


84


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


83


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


85


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)







TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]
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LOCATION BENEFIT SOURCE


TRAVEL DATE(S)
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LOCATION BENEFIT SOURCE


TRAVEL DATE(S)
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LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


90


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)
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LOCATION BENEFIT SOURCE


TRAVEL DATE(S)
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LOCATION BENEFIT SOURCE


TRAVEL DATE(S)
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LOCATION BENEFIT SOURCE


TRAVEL DATE(S)
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LOCATION BENEFIT SOURCE


TRAVEL DATE(S)
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LOCATION BENEFIT SOURCE


TRAVEL DATE(S)







TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
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TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]
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[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]
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LOCATION BENEFIT SOURCE


TRAVEL DATE(S)
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LOCATION BENEFIT SOURCE


TRAVEL DATE(S)
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LOCATION BENEFIT SOURCE


TRAVEL DATE(S)
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LOCATION BENEFIT SOURCE


TRAVEL DATE(S)
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LOCATION BENEFIT SOURCE


TRAVEL DATE(S)
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LOCATION BENEFIT SOURCE


TRAVEL DATE(S)







PAGE OF PAGES YEAR
2 2 2016


Hotel X $280


Air Transportation X $825


Meals X $120


                              


CC/ Lodging X $400.00 


                             


                           


                              


CC/ Lodging/ 
Meals X $1,035.00 


                             


                           


                              


Lodging/ 
Registration X $1,580.00 


CC X $250.00 


                           


                              


Lodging/ CC X $791.00 


                             


                           


                              


CC X $400.00 


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2016


NEGATIVE 
REPORT


OGE Form-1353
(OGE-Approved Alternative for SF-326)


February 2011
              010- MARCH 31, 2011


        OURCE
                     ravel expenses are accepted under other authority.  


        


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


TOTAL 
AMOUNT


BENEFIT 
DESCRIPTION







Lodging/ 
Registration X $1,222.00 


                           


                              


Lodging/ 
Registration X $364.00 


                             


                           


                              


Meals/ Lodging X $420.00 


POV/ Meals X $250.00 


                           


                              


                              


CC/ Lodging X $3,440.00 


                           


                              


Cc/ Lodging/ 
Parking/ Meals X $1,400.00 


                             


                           


                              


Lodging/ Meals X $358 


                             


                           


                              


Lodging/ Meals X $358.00 


                             







                           


                              


Lodging/ Per 
Diem/ CC X $5,000.00 


                             


                           


                              


Lodging/ Meals/ 
Taxi/ Ground CC X $1,638.00 


                             


                           


                              


                             


                           


                              


Lodging/ Meals X $400.00 


                             


                           


                              


Lodging/ Meals X $320.00 


                             


                           


                              


CC/ Lodging/ Per 
Diem/ Taxi/ 
Parking


X $1,748.00 


                             


                           


                              


Lodging/ Meals X $282.00 


Meals/ Mileage/ 
Parking X $166.00 


                           


                              







                             


                           


                              


CC/Lodging/ 
Meals X $620.00 


                             


                           


                              


                             


                           


                              


Meals/ Lodging X $770.00 


                             


                           


                              


                             


                           


                              


                             


                              


Lodging / Meals X $400.00 


                             


                           


                              


CC/ Lodging/ 
Meals X $2,987.00 


                             


                           







                              


                             


                           


                              


                              


CC/ Lodging/ 
Meals X $3,100.00 


                             


                           


                              


                             


                           


                             


                           


                              


                             


                           


                              


                             


                           


                              


CC/ Lodging X $2,233.00 


                             


                           


                              







Lodging/ Meals/ 
CC X $660.00 


                             


                           


                              


Meals/ Lodging X $770.00 


                             


                           


                              


Lodging/ Meals X $245.25 


                             


                           


                              


Lodging/ Meals X $245.25 


                             


                           


                              


CC/ Meals / 
Lodging/ Parking/ 
Mileage


X $2,632.00 


                             


                           


                              


Lodging/ Reg. 
Fee X $478.00 


                             


                           


                              


CC X $540.00 


Lodging/Meals X $316.00 







                           


                              


Taxi/ Parking/ 
voucher fee X $92.00 


Lodging/ Meals/ 
CC X $1,491.00 


                           


                              


Cc/ lodging/ 
Meals/ 
Registration


X $1,653.00 


                             


                           


                              


Cc/ Lodging/ 
Meals X $1,160.00 


                             


                           


                              


Meals X $75.00 


CC/ Lodging X $889.00 


                           


                              


CC/ lodging/ 
Meals X $4,606.00 


                             


                           


                              


Lodging X $520.00 


CC/ Meals X $976.00 


                           


                              







CC/ Lodging/ 
Meals X $2,400.00 


                             


                           


                              


Lodging X $153.00 


                             


                           


                              


Lodging/ Meals/ 
Mileage/ 
Registration


X $440.15 


                             


                           


                              


CC/ Lodging/ 
Meals X $744.00 


                             


                           


                              


Lodging/ Meals X $140.00 


                             


                           


                              


Lodging/ Meals X $486.00 


                             


                           


                              


Lodging/ 
Conference 
Registration


X $855.00 


                             







                           


                              


CC/ Lodging/ 
Meals/ Taxi/ Reg 
fee


X $943.00 


                             


                           


                              


Meals/ Lodging X $347.50 


                             


                           


                              


CC/ Lodging/ 
Meals/ 
Parking/mileage


X $2,632.00 


                             


                           


                              


CC/ Lodging X $1,099.74 


                             


                           


                              
CC/Per diem/ 
Conference fee X $453.20 


                             


                           


                              


CC/ Lodging/ 
Meals/ Parking / 
Mileage/ BART 


X $1,423.00 


                             


                           







                              


Lodging/  CC X $601.28 


Per Diem/ 
Mileage X $101.00 


                           


                              


Lodging X $228.26 


                             


                           


                              


CC/ Lodging/ Per 
diem/ Taxi/ 
Shuttle


X $1,015.00 


                             


                           


                              


Lodging X $133.00 


Meals/ Parking X $141.00 


                           


                              


CC/ Lodging X $850.00 


                             


                           


                              


Reg fee X $120.00 


                             


                           


                              


CC X $1,500.00 







Per Diem X 1,511.00


                           


                              


CC/ Lodging/ 
Hotel 
taxes/Taxi/Meals/
Mileage/ Parking


X $725.00 


                             


                           


                              


                              


                             


                           


                              


                              


                             


                           


                              


                              


                             


                           


                              


                              


                             


                           


                              


                              


                             


                           


                              


                              


                             


                           


                              


                              


                             


                           


                              







                              


                             


                           


                              


                              


                             


                           


                              


                              


                             


                           


                              


                              


                             


                           


                              


                              


                             


                           


                              


                              


                             


                           


                              


                              


                             


                           


                              


                              


                             


                           


                              


                              


                             


                           


                              


                              


                             







                           


                              


                              


                             


                           


                              


                              


                             


                           


                              


                              


                             


                           


                              


                              


                             


                           


                              


                              


                             


                           


                              


                              


                             


                           


                              


                              


                             


                           


                              


                              


                             


                           


                              


                              


                             


                           







                              


                              


                             


                           


                              


                              


                             


                           


                              


                              


                             


                           


                              


                              


                             


                           


                              


                              


                             


                           


                              


                              


                             


                           


Internal OGE Use Only


FALSE
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Completing the OGE Form-1353


Saving the Workbook


-


-


-


Preparing Blank Report Forms for Each Sub-Agency  (if applicable)


-


-


-


Completing the General Information


Renaming the Spreadsheet Tabs


-


-


-


-


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.


Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission
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Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP







OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
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USUHS
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USTDA


                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


1 2016


Agency Contact:
Andrew Tobin, 
Deputy Director


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Murray Baskt Speaking -Isolation and 
staging of goose embryos 3/10/2016 Wroclaw, Poland Air Transportation X $350 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Physiologist University of Wroclaw 3/17/2016 03/10/2016-
03/17/2016                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Jay D. Evans
Seminar "Holistic 
Approaches to Honey Bee 
Health"


2/23/2016 Burlington, VT Air Transportation X $250 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging X $200 


Research Leader Unversity of Vermont 2/22/2016 02/21/2016--
2/23/2016 Meals X $16 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Naomi Fukagawa ILSI Annual Meeting 1/23/2016 St Petersburg, FL Air Transportation X $575 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging X $1,008 


Director International Life Sciences 
Institute 1/27/2016 1/23/2016-01/27/2016 Meals/Taxi X $660 


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


U.S. Department of Agriculture
Agricultural Research Service - Northeast Area (Beltsville) NEGATIVE 


REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X


REPORTING 
PERIOD: 


OCTOBER 1, 
2015- MARCH 


31, 2016


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2016


3


LOCATION


TRAVEL DATE(S)


Asia Pacific Forum 
Pacific Rim Foundation 


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


tobin.andrew@oe.usda.gov


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


BENEFIT SOURCE


University of Wroclaw


BENEFIT SOURCE


University of Vermont


BENEFIT SOURCE


International Life 
Sciences Institute


BENEFIT SOURCE





		Instruction Sheet

		Agency Acronym

		RENAME BLANK FORM






Completing the OGE Form-1353


Saving the Workbook


-


-


-


Preparing Blank Report Forms for Each Sub-Agency  (if applicable)


-


-


-


Completing the General Information


Renaming the Spreadsheet Tabs


-


-


-


-


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.


Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission
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Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP







OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
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                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


1 2016


Agency Contact:
Andrew Tobin, 
Deputy Director


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Naomi Fukagawa 12th Nestle International 
Nutrition Symposium 10/21/2015 Lausanne, 


Switzerland


Lodging, Meals, 
Transfers in 
Switzerland


X $1,912.70 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Director Nestle 10/23/2015 10/20/15 - 10/24/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Sarah Gebauer


3rd International 
Conference on Food 
Structures, Digestion and 
Health


10/28/2015 Wellington, New 
Zealand


Airfare and 
Lodging  X 3,134.00


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Clinical Studies 
Coordinator


Almond Board of 
California 10/30/2015 10/24/15 - 11/1/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Vangimalla Reddy


Annual Meeting of the 
Scientific Advisory Board 
of the Co-operative 
Research Programme


10/27/2015 Paris, France Airfare, Hotel, 
Meals and Taxi X $3,044.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


U.S. Department of Agriculture
Agricultural Research Service - Northeast Area (NAA) NEGATIVE 


REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X


REPORTING 
PERIOD: 


OCTOBER 1, 
2015- MARCH 


31, 2016


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2016


3


LOCATION


TRAVEL DATE(S)


Asia Pacific Forum 
Pacific Rim Foundation 


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


tobin.andrew@oe.usda.gov


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


BENEFIT SOURCE


Nestle


BENEFIT SOURCE


Almond Board of 
California


BENEFIT SOURCE


Organization of Economic 
Co-operation and 
Development Co-


operative Research 
Programme


BENEFIT SOURCE







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


 


Research Leader


Organization of Economic 
Co-operation and 
Development Co-
operative Research 
Programme


10/30/2015 10/26/15 - 10/30/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Alanna Moshfegh


Nutrition Research 
Scientific Advisory 
Committee (NRSAC) 
Meeting


11/2/2015 Rosemont, IL Airfare and Meals X $701.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Lodging, Taxi, 
Local 
Transportation


X $312.00 


Research Leader National Dairy Council 11/3/2015 11/2/15 - 11/3/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Dennis Timlin


Conference of Agriculture 
Innovation Studies for 
Coping with Climate 
Change and Food 
Security


11/8/2015 Taichung, Taiwan Airfare, Lodging 
and Meals X $3,784.70 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Soil Scientist Taiwan Agricultural 
Research Institute 11/14/2015 11/6/15 - 11/13/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Vangimalla Reddy


Conference of Agriculture 
Innovation Studies for 
Coping with Climate 
Change and Food 
Security


11/8/2015 Taichung, Taiwan Airfare, Lodging 
and Meals X $3,784.70 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Leader Taiwan Agricultural 
Research Institute 11/14/2015 11/6/15 - 11/13/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


John Cole
Dairy Records 
Management Systems 
(DRMS) Annual Meeting


11/10/2015 New Orleans, LA Airfare X $600.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Hotel X $350.00 


Research Geneticist DRMS 11/12/2015 11/6/15 - 11/12/15                            


LOCATION


TRAVEL DATE(S)


4


LOCATION


7


LOCATION


TRAVEL DATE(S)


TRAVEL DATE(S)


5


6


LOCATION


TRAVEL DATE(S)


BENEFIT SOURCE


National Dairy Council


BENEFIT SOURCE


Taiwan Agricultural 
Research Institute


BENEFIT SOURCE


Taiwan Agricultural 
Research Institute


BENEFIT SOURCE


DRMS







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


 TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Lewis Ziska
Transitioning Cereal 
Systems to Adapt to 
Climate Change meeting


11/13/2015 Minneapolis, MN Airfare, Hotel and 
Registration X $1,722.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Plant 
Physiologist


Regional Approaches to 
Climate Change for 
Pacific Northwest 
Agriculture


11/14/2015 11/12/15 - 11/18/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Jitendra Patel


USA and Japan Natural 
Resources (UJNR) Food 
and Agriculture Panel 
meeting


11/15/2015 Kanazawa, Japan Hotel and Parking X $1,300.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Lead Scientist National Food Research 
Institute (NFRI) 11/18/2015 11/13/15 - 11/19/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Michel Cavigelli Albert Lea Seeds Annual 
Organic Open House 11/20/2015 Albert Lea, MN Hotel, Rental Car 


and Meal X $266.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Soil Scientist Albert Lea Seed 11/20/2015 11/19/15 - 11/21/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Joan Lunney
BRD CAP PI and SAB 
meeting in preparation for 
annual progress report


1/7/2016 San Diego, CA
Hotel, Taxi, 
Parking and 
Mileage


X $556.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals X $50.00 


Research Chemist Texas A&M University, 
Veterinary Pathobiology 1/7/2016 1/6/16 - 1/12/16                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Jean-Luc Jannink Cassava Mosaic Disease2 
Workshop 10/6/2015 Seattle, WA Airfare X $1,300.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


9


LOCATION


TRAVEL DATE(S)


10


LOCATION


8


LOCATION


TRAVEL DATE(S)


TRAVEL DATE(S)


11


LOCATION


TRAVEL DATE(S)


12


LOCATION


TRAVEL DATE(S)


Texas A&M University, 
Veterinary Pathobiology


BENEFIT SOURCE


Cornell University


BENEFIT SOURCE
Regional Approaches to 


Climate Change for 
Pacific Northwest 


Agriculture


BENEFIT SOURCE


National Food Research 
Institute (NFRI)


BENEFIT SOURCE


Albert Lea Seed


BENEFIT SOURCE







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


 Research Geneticist Cornell University 10/7/2015 10/5/15 - 10/8/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Jean-Luc Jannink Cassava Mosaic Disease2 
Workshop 10/6/2015 Seattle, WA Hotel and Meals X $576.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Geneticist Bill & Melinda Gates 
Foundation 10/7/2015 10/5/15 - 10/8/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Michelle Cilia


2nd Internatonal SFB 796 
(Sonderforschungsbereich-
Collaborative Research 
Center) Conference


10/4/2015 Erlangen, Germany


Airfare, Hotel, 
Meals, Taxi and 
Conference 
Registration


X $2,618.50 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Molecular 
Biologist


Friedrich-Alexander 
University (FAU) 10/6/2015 10/2/15 - 10/7/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Michale Tunick Chemistry Department 
Colloquium, Fall 2015 10/9/2015 Middletown, CT Airfare, Hotel, 


Meals and Taxi X $425.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Chemist Wesleyan University, 
Chemistry Department 10/9/2015 10/9/15 - 10/10/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Marshall Miller 6th Biennial Berry Health 
Benefits Symposium 10/13/2015 Madison, WI


Airfare, Hotel and 
Conferernce 
Registration


X $1,510.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Research Psychologist The National Berry Crops 
Initiative 10/15/2015 10/12/15 - 10/16/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Barbara Shukitt-Hale 6th Biennial Berry Health 
Benefits Symposium 10/13/2015 Madison, WI


Airfare, Hotel and 
Conference 
Registration


X $1,510.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


TRAVEL DATE(S)


13


LOCATION


TRAVEL DATE(S)


14


LOCATION


TRAVEL DATE(S)


15


LOCATION


16


LOCATION


TRAVEL DATE(S)


17


LOCATION


TRAVEL DATE(S)


BENEFIT SOURCE


Wesleyan University, 
Chemistry Department


BENEFIT SOURCE


Bill & Melinda Gates 
Foundation


BENEFIT SOURCE


Friedrich-Alexander 
University (FAU)


BENEFIT SOURCE


The National Berry Crops 
Initiative


BENEFIT SOURCE


The National Berry Crops 
Initiative







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


 Research Psychologist The National Berry Crops 
Initiative 10/15/2015 10/12/15 - 10/16/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Amy Tabb


Marquette University 
Department of Electrical 
and Computer 
Engineering Colloquium 
Series


10/13/2015 Milwaukee, WI Airfare, Hotel and 
Meals X $550.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Engineer


Marquette University 
Department of Electrical 
and Computer 
Engineering 


10/13/2015 10/12/15 - 10/14/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Jian Duan


Department Seminar on 
Invasion Biology and 
Classical Biological 
Control of Emerald Ash 
Borer


10/14/2015 Lexington, KY
Airfare, Hotel, 
Meals, Taxi and 
Parking


X $897.20 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Entomologist
Department of 
Entomology, University of 
Kentucky, Lexington


10/16/2015 10/14/15 - 10/16/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Li Li


4th International 
Conferrence on Selenium 
in the Environment and 
Human Health


10/18/2015 Sao Paulo, Brazil Airfare, Hotel and 
Registration X $2,141.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Molecular 
Biologist


Local Organizing 
Committee - University 
Estadual Paulista


10/21/2015 10/16/15 - 10/23/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Li Li Federal University of 
Lavras seminar & meeting 10/22/2015 Lavras, Brazil Hotel, Meals and 


Registration X $964.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


21


LOCATION


TRAVEL DATE(S)


LOCATION


18


LOCATION


TRAVEL DATE(S)


19


LOCATION


TRAVEL DATE(S)


20


TRAVEL DATE(S)


BENEFIT SOURCE


Marguette University 
Department of Electrical 


and Computer 
Engineering


BENEFIT SOURCE


Department of 
Entomology, University of 


Kentucky, Lexington


BENEFIT SOURCE


Local Organizing 
Committee - University 


Estadual Paulista


BENEFIT SOURCE


Federal University of 
Lavras







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


 Research Molecular 
Biologist


Federal University of 
Lavras 10/24/2015 10/16/15 - 10/23/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Richard Alan Humber Science Without Borders 
Project 10/19/2015 Goiania, Brazil Airfare, Meals 


and Shuttle X $3,342.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Microbiologist


Institute de Patologia 
Tropical e Saude Publico 
(IPTSP), University 
Federal of Goias (UFG)


11/21/2015 10/17/15 - 11/22/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Barbara Shukitt-Hale 12th European Nutrition 
Conference (FENS 2015) 10/20/2015 Berlin, Germany


Airfare, Hotel, 
Meals, Taxi and 
Conference 
Registration


X $3,750.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Psychologist California Walnut 
Commission 10/23/2015 10/18/15 - 10/23/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Guoying Chen LujiaCi Lecture 10/26/2015 Xiamen, China Hotel and Meals X $140.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Chemist
Xiamen University (SNM), 
College of Chemistry and 
Chemical Engineering


10/27/2015 10/22/15 - 11/10/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Guoying Chen


The First ERRC-FAFU 
Symposium on Predictive 
Microbiology and Residue 
Analysis


10/28/2015 Fuzhou City, China Airfare, Hotel and 
Meals X $1,280.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Chemist


Fujian Agriculture and 
Forestry University 
(FAFU), College of Food 
Science


10/30/2015 10/22/15 - 11/10/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


22


LOCATION


LOCATION


24


LOCATION


TRAVEL DATE(S)


LOCATION


TRAVEL DATE(S)


TRAVEL DATE(S)


23


25


LOCATION


TRAVEL DATE(S)


Xiamen University (SNM), 
College of Chemistry and 


BENEFIT SOURCE


Fujian Agriculture and 
Forestry University 


(FAFU), College of Food 
Science


BENEFIT SOURCE


BENEFIT SOURCE
Institute de Patologia 


Tropical e Saude Publico 
(IPTSP)  University 


BENEFIT SOURCE


California Walnut 
Commission


BENEFIT SOURCE







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


 
Guoying Chen


Shanghai Institute for 
Food and Drug Control 
(SIFDC) Conference


10/31/2015 Shanghai, China Airfare, Hotel and 
Meals X $330.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Chemist
Shanghai Institute for 
Food and Drug Control 
(SIFDC) 


11/2/2015 10/22/15 - 11/10/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Guoying Chen Science and Technology 
Week workshop 11/4/2015 Chengdu, China Airfare, Hotel and 


Meals X $410.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Chemist Southwest University of 
Nationalities (SWUN) 11/6/2015 10/22/15 - 11/10/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Guoying Chen


China Agriculture 
University (CAU), College 
of Food Science and 
Nutritional Engineering 
Conference


11/7/2015 Beijing, China Airfare, Hotel and 
Meals X $380.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Chemist China Agriculture 
University (CAU) 11/10/2015 10/22/15 - 11/10/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


John Norelli
New Zealand Institute for 
Plant and Food Research 
Conference


10/26/2015


Palmerston North, 
Hawkes Bay, 
Auckland and 
Hamilton, New 
Zealand


Airfare and Hotel X $3,500.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Plant Pathologist New Zealand Institute for 
Plant and Food Research 11/13/2015 10/24/15 - 11/13/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


26
TRAVEL DATE(S)


27


LOCATION


TRAVEL DATE(S)


28


LOCATION


TRAVEL DATE(S)


29


LOCATION


TRAVEL DATE(S)


LOCATION BENEFIT SOURCE


BENEFIT SOURCE


New Zealand Institute for 
Plant and Food Research


Shanghai Institute for 
Food and Drug Control 


(SIFDC)


BENEFIT SOURCE


Southwest University of 
Nationalities (SWUN)


BENEFIT SOURCE


China Agriculture 
University (CAU), College 


of Food Science and 
Nutritional Engineering 


Conference







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


 


Cheng-An Hwang


First ERRC-Fujian 
Agriculture and Forest 
University Symposium on 
Predictive Microbiology 
and Chemical Residue 
Analysis


10/28/2015 Fuzhou City, China Airfare, Hotel and 
Meals X $3,000.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Food 
Technologist


Fujian Agriculture and 
Forest University 10/30/2015 10/25/15 - 11/7/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Cheng-An Hwang
Shanghai Institute for 
Food and Drug Control 
Conference


11/1/2015 Shanghai, China Hotel, Meals and 
Train X $900.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Food 
Technologist


Shanghai Institute for 
Food and Drug Control 11/3/2015 10/25/15 - 11/7/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Cheng-An Hwang


Henan Agricultural 
University, College of 
Food Science and 
Technology Conference


11/6/2015 Zhengzhou, China Hotel, Meals and 
Train X $600.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Food 
Technologist


Henan Agricultural 
University 11/7/2015 10/25/15 - 11/7/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Yanhong Liu


Symposium on Predictive 
Microbiology and 
Chemical Residue 
Analysis


10/29/2015 Fuzhou, China Airfare, Hotel and 
Meals X $400.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Microbiologist Fuzhou Agriculture and 
Forestry University 10/31/2015 10/25/15 - 11/5/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Yanhong Liu


Symposium on Predictive 
Microbiology and 
Chemical Residue 
Analysis


10/31/2015 Tianjin, China Airfare, Hotel and 
Meals X $2,200.00 


34


LOCATION


BENEFIT SOURCE


Shanghai Institute for 
Food and Drug Control 


(SIFDC)


BENEFIT SOURCE


Henan Agricultural 
University


BENEFIT SOURCE


Fuzhou Agriculture and 
Forestry University


30


TRAVEL DATE(S)


Fujian Agriculture and 
Forestry University 


(FAFU), College of Food 
Science


31


LOCATION


TRAVEL DATE(S)


32


LOCATION


TRAVEL DATE(S)


33


LOCATION


TRAVEL DATE(S)


BENEFIT SOURCE


Tianjin Academy of 
Agicultural Sciences







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


 TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Microbiologist Tianjin Academy of 
Agricultural Sciences 11/2/2015 10/25/15 - 11/5/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Yanhong Liu


Symposium on Predictive 
Microbiology and 
Chemical Residue 
Analysis


10/31/2015 Guangzhou, China Airfare, Hotel and 
Meals X $400.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Microbiologist Guangdong Institute of 
Microbiology 11/3/2015 10/25/15 - 11/5/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Pina Fratamico


Annual Meeting of the 
Italian Assoc. of 
Veterinary Hygienists 
(A.I.V.I.) 


10/28/2015 Sorrento, Italy Airfare, Hotel and 
Meals X $2,300.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Microbiologist Italian Association of 
Veterinary Hygienists 10/30/2015 10/26/15 - 10/31/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Arland Hotchkiss Ph.D. Defense 10/28/2015 Lyngby, Denmark Airfare, Hotel and 
Taxi X $4,000.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Plant 
Physiologist


Technical University of 
Denmark 11/6/2015 10/26/15 - 11/7/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Barbara Shukitt-Hale


7th International 
Conference on 
Polyphenols and Health 
(ICPH 2015)


10/27/2015 Tours, France


Airfare, Hotel, 
Meals and 
Conference 
Registration


X $3,750.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Psychologist PepsiCo 10/30/2015 10/26/15 - 10/30/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


TRAVEL DATE(S)


35


LOCATION


TRAVEL DATE(S)


36


LOCATION


TRAVEL DATE(S)


37


LOCATION


TRAVEL DATE(S)


38


LOCATION


TRAVEL DATE(S)


LOCATION


BENEFIT SOURCE


PepsiCo


BENEFIT SOURCE


Guangdong Institute of 
Microbiology


BENEFIT SOURCE


Italian Association of 
Veterinary Hygienists


BENEFIT SOURCE


Technical University of 
Denmark


BENEFIT SOURCE







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


 


Gennaro Fazio


Meeting - External 
reviewer of the Core 
Program in Citrus Plant 
Breeding and 
Improvement


10/26/2015 Exeter and Riverside, 
CA


Airfare, Hotel and 
Meals X $1,500.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Geneticist Citrus Research Board 10/30/2015 10/26/15 - 10/31/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Zongrang Liu
The Second International 
Horticulture Research 
Conference


10/29/2015 Davis, CA Airfare X $395.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Molecular Biologist University of California, 
Davis 11/2/2015 10/29/15 - 11/2/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Li Li
The Second International 
Horticulture Research 
Conference


10/29/2015 Davis, CA Airfare X $510.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Hotel X $290.00 


Research Molecular 
Biologist


University of California, 
Davis 11/2/2015 10/29/15 - 11/2/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Lihan Huang


First ERRC-Fujian 
Agriculture and Forest 
University Symposium on 
Predictive Microbiology 
and Chemical Residue 
Analysis


10/28/2015 Fuzhou, China Airfare, Lodging 
and Meals X $2,100.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Leader Fujian Agriculture and 
Forestry University 10/30/2015 10/25/15 - 11/7/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


42


LOCATION


LOCATION


TRAVEL DATE(S)


41


LOCATION


TRAVEL DATE(S)


39


TRAVEL DATE(S)


40


LOCATION


TRAVEL DATE(S)


University of California, 
Davis


BENEFIT SOURCE


Fujian Agriculture and 
Forestry University 


(FAFU), College of Food 
Science


BENEFIT SOURCE


Citrus Research Board


BENEFIT SOURCE


University of California, 
Davis


BENEFIT SOURCE







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


 


Lihan Huang
Shanghai Institute for 
Food & Drug Control 
Conference


10/31/2015 Shanghai, China Airfare, Lodging 
and Meals X $300.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Leader Shanghai Institute for 
Food & Drug Control 11/2/2015 10/25/15 - 11/7/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Lihan Huang Henan Agricultural 
University Conference 11/5/2015 Fuzhou, China Airfare, Lodging 


and Meals X $300.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Leader Henan Agricultural 
University 11/7/2015 10/25/15 - 11/7/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Aida Elizabeth Rieder


Vaccines Against 
Antigenetically Variable 
Viruses Symposium 
(VAAVV)


11/5/2015 Ames, IA Airfare, Hotel, 
Meals and Taxi X $1,294.20 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Molecular 
Biologist Iowa State University 11/8/2015 11/5/15 - 11/8/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Vijay Juneja


10th International 
Conference - 
Detection/Control 
Methods for Food Safety


11/10/2015 San Francisco, CA Airfare, Hotel and 
Meals X $1,500.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Microbiologist Seoul National University 11/11/2015 11/7/15 - 11/12/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Doreen Ware DOE Kbase Project Fall 
Executive Retreat 11/9/2015 Chicago, IL Airfare, Hotel and 


Meals X $542.00 


TRAVEL DATE(S)


44


LOCATION


TRAVEL DATE(S)


43


TRAVEL DATE(S)


47


LOCATION


45


LOCATION


TRAVEL DATE(S)


46


LOCATION BENEFIT SOURCE


Seoul National University


BENEFIT SOURCE


Cold Spring Harbor 
Laboratory


Shanghai Institute for 
Food and Drug Control 


(SIFDC)


BENEFIT SOURCE


Henan Agricultural 
University


BENEFIT SOURCE


Iowa State University







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


 TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Computational Biologist Cold Spring Harbor 
Laboratory 11/10/2015 11/9/15 - 11/10/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Edward Buckler


2015 Scientific Advisory 
Board Meeting of the 
Gregor Mendel Institute of 
Molecular Plant Biology


11/12/2015 Vienna, Austria Airfare, Hotel and 
Meals X $3,139.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Geneticist Gregor Mendel Institute 11/13/2015 11/10/15 - 11/14/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Jason Londo VitiNord 2015 Conference 11/11/2015 Nebraska City, NE Airfare X $400.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Hotel and Meals X $580.00 


Research Geneticist VitiNord 11/14/2015 11/11/15 - 11/14/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Ransom Baldwin


Evaluation of proposal 
submitted to the NSERC 
in the Industrial Research 
Chair Opportunity


11/12/2015 Edmonton, Alberta, 
Canada


Airfare, Hotel, 
Meals and Taxi X $1,600.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Animal 
Scientist


Natural Sciences and 
Engineering Research 
Council of Canada 
(NSERC)


11/13/2015 11/12/15 - 11/14/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Sevim Erhan


44th Annual US-Japan 
Natural Resources 
(UJNR) Food and 
Agriculture Panel Meeting


11/15/2015 Kanazawa, Japan Hotel, Misc X $1,000.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              TRAVEL DATE(S)


TRAVEL DATE(S)


48


LOCATION


TRAVEL DATE(S)


49


LOCATION


TRAVEL DATE(S)


50


LOCATION


TRAVEL DATE(S)


51


LOCATION


BENEFIT SOURCE


Gregor Mendel Institute


BENEFIT SOURCE


VitiNord


BENEFIT SOURCE


Natural Sciences and 
Engineering Research 


Council of Canada 
(NSERC)


BENEFIT SOURCE


National Food Research 
Institute







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


 Center Director National Food Research 
Institute 11/18/2015 11/13/15 - 11/19/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


LinShu Liu


44th Annual US-Japan 
Natural Resources 
(UJNR) Food and 
Agriculture Panel Meeting


11/15/2015 Kanazawa, Japan Airfare and Hotel X $1,000.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Chemist National Food Research 
Institute 11/18/2015 11/13/15 - 11/19/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Brendan Niemira


44th Annual US-Japan 
Natural Resources 
(UJNR) Food and 
Agriculture Panel Meeting


11/15/2015 Kanazawa, Japan Hotel, In-country 
travel X $1,000.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Leader National Food Research 
Institute 11/18/2015 11/13/15 - 11/19/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Akwasi Boateng


Development of Fast 
Pyrolysis Processes for 
Residual Biomass and 
Microalgae


11/15/2015 Brasilia, Brazil Airfare, Hotel X $4,600.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Chemical Engineer Brazilian Science without 
Border (CAPES) program 12/11/2015 11/14/15 - 12/12/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


52


LOCATION


TRAVEL DATE(S)


53


LOCATION


TRAVEL DATE(S)


54


LOCATION


TRAVEL DATE(S)


LOCATION


BENEFIT SOURCE


National Food Research 
Institute


BENEFIT SOURCE


National Food Research 
Institute


BENEFIT SOURCE


Brazilian Science without 
Border (CAPES) Program


BENEFIT SOURCE







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


 


Richard Ashby 2015 New Horizon in 
Biotechnology 11/22/2015 Trivandrum, India Hotel, Meals and 


Taxi X $900.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Microbiologist


National Institute for 
Interdisciplinary Science 
and Technology 
(NIIST)/New Horizons in 
Biotechnology


11/25/2015 11/19/15 - 11/26/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Phoebe Qi Guangxi Buffalo Research 
Institute Conference 11/30/2015 Nanning, Guangxi, 


China
Airfare, Hotel, 
Meals and Taxi X $2,150.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Chemist
Buffalo Research Institute, 
Chinese Academy of 
Agricultural Science


12/6/2015 11/28/15 - 12/06/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Phoebe Qi
Institute of Quality and 
Standard for Agro-
Products Conference


11/30/2015 Hangzhou, China Airfare, Hotel, 
Meals and Taxi X $675.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Chemist Hangzhou, China 12/6/2015 11/28/15 - 12/6/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


TRAVEL DATE(S)


57


LOCATION


TRAVEL DATE(S)


LOCATION


56


LOCATION


55


TRAVEL DATE(S)


National Institute for 
Interdisciplinary Science 


and Technology 
(NIIST)/New Horizons in 


Bioitechnology


BENEFIT SOURCE


Buffalo Research 
Institute, Chinese 


Academy of Agricultural 
Science


BENEFIT SOURCE


Institute of Quality and 
Standard for Agro-


Products


BENEFIT SOURCE







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


 


Phoebe Qi College of Animal 
Sciences Conference 11/30/2015 Hangzhou, Zhejiang, 


China
Airfare, Hotel, 
Meals and Taxi X $675.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Chemist
College of Animal 
Sciences, Zhejiang 
University


12/6/2015 11/28/15 - 12/6/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Luis Rodriguez


Rapid Efficient Response 
to High Consequences 
Animal Diseases 
Workshop


12/1/2015 Mexico City, Mexico Airfare, Taxi X $915.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Hotel X $310.00 


Research Leader


Cooperative Program in 
Research and Technology 
for the Northern Region 
(PROCINORTE)


12/3/2015 12/1/15 - 12/4/14                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Edward Buckler
Genomic Open-Source 
Breeding Infromatics 
Initiative Project Meeting


12/2/2015 Texcoco, Mexico Airfare X $460.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Geneticist Cornell University 12/6/2015 12/2/15 - 12/6/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Leon Kochian
XVI National Congress of 
Biochemistry and Plant 
Molecular Biology


12/7/2015 Quertaro, Mexico Airfare and Hotel X $1,128.60 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              
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LOCATION


TRAVEL DATE(S)


58


TRAVEL DATE(S)


59


LOCATION


TRAVEL DATE(S)


BENEFIT SOURCE


Cornell University
60


LOCATION


TRAVEL DATE(S)


College of Animal 
Sciences, Zhejiang 


University


BENEFIT SOURCE


Cooperative Program in 
Research and 


Technology for the 
Northern Region 
(PROCINORTE)


BENEFIT SOURCE


Universidad Nacional 
Auronoma de Mexico







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


 Research Plant 
Physiologist


Universidad Nacional 
Autonoma de Mexico 12/11/2015 12/5/15 - 12/11/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Fumiomi Takeda
Great Lakes Fruit, 
Vegetable and Farm 
Market EXPO


12/8/2015 Grand Rapids, MI
Airfare, Hotel, 
Meals, Parking 
Fees, Taxi


X $1,037.01 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Horticulturist


Michigan State 
Horticultural Society and 
Michigan Vegetable 
Council


12/9/2015 12/7/15 - 12/10/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Steven Lehotay Distinguished Lecture 
Series 12/8/2015 Lima, Peru Airfare, Hotel X $1,600.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Hotel, Meals and 
Taxi X $500.00 


Research Chemist
Foundation for the Study 
of Traditional Sciences 
and Arts


12/11/2015 12/7/15 - 12/12/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Anna Porto-Fett
STEC CAP Executive 
Management Team 
Meeting


12/9/2015 Lincoln, NE Hotel X $300.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Food 
Technologist/Microbiolo
gist


University of Nebraska-
Lincoln 12/12/2015 12/8/15 - 12/13/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


John Luchansky
STEC CAP Executive 
Management Team 
Meeting


12/9/2015 Lincoln, NE Airfare, Hotel, 
Meals, Rental Car X $1,050.00 
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LOCATION


TRAVEL DATE(S)


64


LOCATION


TRAVEL DATE(S)


LOCATION


TRAVEL DATE(S)


65


LOCATION


University of Nebraska-
Lincoln


BENEFIT SOURCE


BENEFIT SOURCE


Michigan State 
Horticultural Society and 


Michigan Vegetable 
Council


BENEFIT SOURCE


Foundation for the Study 
of Traditional Sciences 


and Arts


BENEFIT SOURCE


University of Nebraska-
Lincoln







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


 TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Microbiologist University of Nebraska-
Lincoln 12/12/2015 12/8/15 - 12/13/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Clinton Church UV-Discovery Farms 
Conference 12/15/2015 Wisconsin Dells, WI


Airfare, Hotel, 
Meals and Rental 
Car


X $1,360.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Chemist Minnesota Agricultural 
Water Resource Center 12/15/2015 12/14/15 - 12/16/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Ann Callahan
Annual Interdepartmental 
Plant Breeding, Genetics 
& Biotech Symposium


12/18/2015 East Lansinig, MI Airfare and Hotel X $600.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Reseach Geneticist Michigan State University 12/18/2015 12/17/15 - 12/19/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


John Norelli RosBREED's Advisory 
Panel Meeting 1/7/2016 San Diego, CA Airfare, Hotel and 


Meals X $1,659.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Plant Pathologist Michigan State University 1/7/2016 1/6/16 - 1/9/16                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Jean-Luc Jannink


Gates Foundation Project 
meeting:  Plant and 
Animal Genome XXIV 
Conference


1/6/2016 San Diego, CA Airfare, Hotel and 
Meals X $2,455.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Geneticist Cornell University 1/13/2015 1/6/16 - 1/23/16                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               
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LOCATION


TRAVEL DATE(S)


LOCATION


TRAVEL DATE(S)


66


LOCATION


TRAVEL DATE(S)


67


LOCATION


TRAVEL DATE(S)


68


LOCATION


TRAVEL DATE(S)


BENEFIT SOURCE


BENEFIT SOURCE


Minnesota Agricultural 
Water Resource Center


BENEFIT SOURCE


Michigan State University


BENEFIT SOURCE


Michigan State University


BENEFIT SOURCE


Cornell University







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


 Gan-Yuan Zhong Pant and Animal Genome 
Conference 1/9/2016 San Diego, CA Hotel and 


Registration X $1,348.02 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Arifare X $500.00 


Research Leader Scherago International 1/13/2016 1/6/16 - 1/13/16                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Yingzhen Yang Plant and Animal Genome 
Conference 1/9/2016 San Diego, CA Hotel and 


Registration X $1,348.02 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Airfare X $250.00 


Support Scientist Scherago International 1/13/2016 1/8/16 - 1/13/16                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Jean-Luc Jannink


NEXTGEN Cassava 
Breeding Project Annual 
Meeting and the Global 
Cassava Partnership 
Meeting


1/16/2016 Nanning, Guangxi, 
China


Airfare, Hotel and 
Meals X $3,666.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Geneticist Cornell University 1/22/2016 1/13/16 - 1/23/16                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Xiaohong Wang
1st Annual GLOBAL CAP 
Meeting & University of ID 
Potato Conference


1/17/2016 Moscow, ID Airfare, Hotel, 
Meals and Taxi X $1,784.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Molecular 
Biologist


University of Idaho 
(College of Agricultural 
and Life Sciences)


1/21/2016 1/17/16 - 1/22/16                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Fumiomi Takeda Annual Blueberry 
Conference 1/25/2016 Portland, OR Hotel and Meals X $317.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Horticulturist Oregon State University 1/25/2016 1/23/6 - 1/31/16                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               LOCATION
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TRAVEL DATE(S)


TRAVEL DATE(S)
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LOCATION


TRAVEL DATE(S)


71


LOCATION


TRAVEL DATE(S)


72


LOCATION


TRAVEL DATE(S)


73


LOCATION


BENEFIT SOURCE


Cornell University


Scherago International


BENEFIT SOURCE


Scherago International


BENEFIT SOURCE


University of Idaho 
(College of Agricultural 


Life Sciences)


BENEFIT SOURCE


Oregon State University


BENEFIT SOURCE







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


 


Fumiomi Takeda
58th Annual Horticulture 
Grower Short Course and 
Pacific Agriculture Show


1/28/2016 Abbortsford, Canada Hotel X $351.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Airfare and Meals X $1,135.67 


Horticulturist
Lower Mainland 
Horticultural Improvement 
Association


1/30/2016 1/26/16 - 1/31/16                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Gennaro Fazio


International Fruit Tree 
Association Annual 
Meeting and Intensive 
Workshop


2/6/2016 Grand Rapids, MI Airfare, Hotel and 
Meals X $1,200.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Geneticist International Fruit Tree 
Association 2/10/2016 2/5/16 - 2/10/16                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Edward Buckler
North Carolina State 
University Genetics 
Seminar


2/8/2016 Raleigh, NC Airfare and Hotel X $435.20 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Geneticist North Carolina State 
University 2/8/2016 2/7/16 - 2/9/16                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Luis Rodriguez


2016 American Society for 
Microbiology (ASM) 
Biodefense and Emerging 
Diseases Research 
Meeting


2/8/2016 Arlington, VA Airfare X  $101.20 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Hotel and Meals X $312.50 


Research Leader American Society for 
Microbiology 2/10/2016 2/9/16 - 2/10/16                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Tracy Leskey Spring Seminar Series at 
the University of Georgia 2/15/2016 Athens, GA Hotel X $93.00 
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TRAVEL DATE(S)
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LOCATION


TRAVEL DATE(S)
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LOCATION


77


LOCATION


TRAVEL DATE(S)


78


LOCATION


TRAVEL DATE(S)


BENEFIT SOURCE


Lower Mainland 
Horticultural Improvement 


Association


BENEFIT SOURCE


International Fruit Tree 
Association


BENEFIT SOURCE


The University of Georgia


North Carolina State 
University


BENEFIT SOURCE


American Society for 
Microbiology







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


 
TRAVELER TITLE EVENT SPONSOR ENDING DATE 


[MM/DD/YYYY]


Airfare, Taxi, 
Meals, Parking, 
Tolls and Fees


X $607.71 


Entomologist The University of Georgia 2/15/2016 2/14/16 - 2/15/16                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Peggy Tomasula 2016 US Dairy Industry 
Spore Seminar 2/16/2016 Pismo Beach, CA Airfare, Hotel and 


Shuttle X $950.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Leader
The US Dairy Export 
Council and the National 
Dairy Council


2/16/2016 2/15/16 - 2/19/16                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Vijay Juneja
Southwest Meat 
Association's 8th Annual 
Mid-Year Conference


2/16/2016 Arlington, TX Hotel X $400.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Microbiologist Southwest Meat 
Association 2/17/2016 2/15/16 - 2/18/16                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


David Douds Ontario Fruit and 
Vegetable Convention 2/17/2016 Niagara Falls, 


Ontario, Canada Airfare X $500.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Hotel & Meals ` X $350.00 


Research Microbiologist Ontario Fruit & Vegetable 
Convention 2/18/2016 2/16/16 - 2/19/16                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Michael Wisniewski
2016 Ontario Fruit and 
Vegetable Convention 
(OFVC)


2/17/2016 Niagara Falls, 
Ontario, Canada


Airfare, Taxi and 
Parking X $554.46 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Hotel X $224.00 


79
TRAVEL DATE(S)
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LOCATION


TRAVEL DATE(S)


TRAVEL DATE(S)
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LOCATION


TRAVEL DATE(S)


82


LOCATION


81


LOCATION


TRAVEL DATE(S)


BENEFIT SOURCE


Ontario Fruit & Vegetable 
Convention


BENEFIT SOURCE


Ontario Fruit & Vegetable 
Convention


BENEFIT SOURCE


The US Dairy Export 
Council and the National 


Dairy Council


BENEFIT SOURCE


Southwest Meat 
Association







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


 
Plant Physiologist Ontario Fruit & Vegetable 


Convention (OFVC) 2/18/2016 2/17/16 - 2/19/16                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Barbara Shukitt-Hale
Seminar at the University 
of Denver, Department of 
Biological Sciences


2/22/2016 Denver, CO Airfare, Hotel and 
Meals X $885.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Psychologist University of Denver 2/22/2016 2/21/16 - 2/23/16                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Barbara Shukitt-Hale


12th Annual Nutrition 
Research Meeting of the 
California Strawberry 
Commission


2/24/2016 San Luis Obispo, CA Airfare, Hotel and 
Meals X $995.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Psychologist California Strawberry 
Commission 2/26/2016 2/24/16 - 2/28/16                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Tracy Leskey 2016 Seminar Series at 
Michigan State University 2/29/2016 East Lansing, MI Airfare and Hotel X $509.10 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals X $88.50 


Entomologist Michigan State University 2/29/2016 2/28/16 - 2/29/16                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


LinShu Liu Huaqiao University 
Conference 3/2/2016 Xiamen, Fujian, 


China


Airfare, Hotel, 
Meals and Local 
Transportation


X $2,600.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Chemist
Huaqiao University, 
School of Biomedical 
Sciences


3/5/2016 2/29/16 - 3/8/16                            


LOCATION
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LOCATION


TRAVEL DATE(S)
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LOCATION


TRAVEL DATE(S)


TRAVEL DATE(S)


86


LOCATION


TRAVEL DATE(S)


87


BENEFIT SOURCE


University of Denver


BENEFIT SOURCE


California Strawberry 
Commission


BENEFIT SOURCE


Michigan State University


BENEFIT SOURCE


Huaqiao University 
School of Biomedical 


Sciences







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


 TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


LinShu Liu
Zhejiang University, 
College of Animal 
Sciences Conference


3/5/2016 Hangzhou, Zhejiang, 
China


Airfare, Hotel, 
Meals and Taxi X $300.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Chemist
Zhejiang University, 
College of Animal 
Sciences


3/6/2016 2/29/16 - 3/8/16                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Stewart Gray


California Department of 
Food & Agriculure 
Program on Grape Virus 
Research


3/2/2016 Davis, CA
Airfare, Hotel, 
Meals, Taxi and 
Internet


X $1,091.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Plant 
Pathologist


University of California, 
Davis 3/2/2016 3/1/16 - 3/3/16                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Fumiomi Takeda
2016 North American 
Raspberry and Blackberry 
Conference


3/1/2016 Williamsburg, VA Hotel X $288.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals X $224.00 


Horticulturist
North American 
Raspberry and Blackberry 
Association


3/4/2016 3/1/16 - 3/4/16                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


John Norelli
FlexQTL Training Session 
and RosBREED2 Project 
Participant Meeting


3/7/2016 East Lansing, MI Airfare and Hotel X $675.20 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals X $221.25 


Plant Pathologist Michigan State University 3/10/2016 3/6/16 - 3/10/16                            
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LOCATION


TRAVEL DATE(S)


BENEFIT SOURCE


Zhegiang University, 
College of Animal 


Sciences


BENEFIT SOURCE


University of California, 
Davis


BENEFIT SOURCE


North American 
Raspberry and 


Blackberry Conference


BENEFIT SOURCE


Michigan State University







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


 TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Richard Bell
FlexQTL Training Session 
and RosBREED2 Project 
Participant Meeting


3/7/2016 East Lansing, MI Airfare and Hotel X $991.34 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals X $265.50 


Research Horticulturist Michigan State University 3/16/2016 3/6/16 - 3/10/16                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Steven Lehotay Pittsburgh Conference 3/7/2016 Atlanta, GA Airfare, Hotel, 
Meals and Taxi X $867.46 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Chemist The Pittsburgh 
Conference 3/11/2016 3/7/16 - 3/11/16                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Nhuan Nghiem 9th Congress of Industrial 
Biotechnology 3/16/2016 Seoul, Korea Registration X $1,149.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Chemical 
Engineer


9th Congress of Industrial 
Biotechnology 3/18/2016 3/12/16 - 3/19/16                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Lihan Huang South China Agricultural 
University Conference 3/29/2016 Guangzhou, China Airfare, Hotel and 


Meals X $2,150.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Leader South China Agricultural 
University 4/1/2016 3/29/16 - 4/8/16                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


                              


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              
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TRAVEL DATE(S)


BENEFIT SOURCE


Michigan State University


BENEFIT SOURCE


The Pittsburgh 
Conference


BENEFIT SOURCE


9th Congress of Indistrial 
Biotechnology


BENEFIT SOURCE


South China Agricultural 
University


BENEFIT SOURCE
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Completing the OGE Form-1353


Saving the Workbook


-


-


-


Preparing Blank Report Forms for Each Sub-Agency  (if applicable)


-


-


-


Completing the General Information


Renaming the Spreadsheet Tabs


-


-


-


-


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.


Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission


Semiannual Report of Payment Accepted







Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP







OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA


                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


1 2016


Agency Contact:
Andrew Tobin, 
Deputy Director


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Robert Klein


Attend Germplasm 
Committee Meeting, 
National Sorghum 
Producers’ Checkoff 
Program 


10/1/2015 Irving, TX Hotel, meals X $251 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Geneticist
National Sorghum 
Producers’ Checkoff 
Program


10/2/2015 10/01/2015-
10/02/2015                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Stephen Del Grosso Research Unit Panel 
Review Meeting 10/5/2015 Westphalia, Germany Airfare, hotel X $1,800 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Soil Scientist
Deutsche 
Forschungsgemeinschaft 
(DFG)


10/6/2015 10/02/2015-
10/08/2015                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


USDA
Agricultural Research Service - Plains Area (NPA) NEGATIVE 


REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X


REPORTING 
PERIOD: 


OCTOBER 1, 
2015- MARCH 


31, 2016


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2016


LOCATION


Asia Pacific Forum 
Pacific Rim Foundation 


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


tobin.andrew@oe.usda.gov


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


BENEFIT SOURCE


National Sorghum 
Producers’ Checkoff 


Program


BENEFIT SOURCE
Deutsche 


Forschungsgemeinschaft  
(DFG)


BENEFIT SOURCE


BENEFIT SOURCE







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


 


Douglas R. Smith


Attend NSF-Food-Energy-
Water (FEW) System 
Trilemma: Balancing 
Reliance on Technological 
and Institutional Solutions 
Workshop


10/7/2015 Seattle, WA Airfare, hotel, 
meals X $1,330 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Soil Scientist
Water Research Ctr, Ctr 
Environ. Research, 
Education &  Outreach


10/9/2015 10/06/2015-
10/09/2015                            


3


TRAVEL DATE(S)


Water Research Ctr, Ctr 
Environ. Research, 


Education &  Outreach





		Instruction Sheet

		Agency Acronym

		Plains Area






Completing the OGE Form-1353


Saving the Workbook


-


-


-


Preparing Blank Report Forms for Each Sub-Agency  (if applicable)


-


-


-


Completing the General Information


Renaming the Spreadsheet Tabs


-


-


-


-


Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission


Semiannual Report of Payment Accepted







Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP







OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA


                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


1 2016


Agency Contact:
Andrew Tobin, 
Deputy Director


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Gao, Suduan Department Seminar at 
University 3/19/2016 Logan, UT Hotel X $240.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $420.00 


Research Soil Scientist Utah State University 3/21/2016 03/19/2016 - 
03/21/2016 Meals


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Banuelos, Gary


4th Int Conference on 
Selenium Society in the 
Environment and Human 
Health


10/15/2015 Sao Paulo, Brazil Hotel X $700 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $2,000 


Research Soil Scientist
Univeristy of Estadual 
Paulista, Campus de 
Tupa, Brazil


10/25/2015 10/15/2015 - 
10/25/2015 Meals X $200 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Boydston, Rick Mint Industry Research 1/18/2016 Las Vegas, NV lodging x $301 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation x $400 


Research Agronomist Mint Industry Research 1/21/2016 01/18/2016-
01/21/2016 Per Diem x $192 


BENEFIT SOURCE
Utah State University, 


Dept of Plants, Soils, and 
Climate


BENEFIT SOURCE


Univeristy of Estadual 
Paulista, Campus de 


Tupa. Scientists, 
professors, and students


BENEFIT SOURCE
Washington State 


University


BENEFIT SOURCE
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EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


tobin.andrew@oe.usda.gov


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


Asia Pacific Forum 
Pacific Rim Foundation 
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LOCATION


TRAVEL DATE(S)


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


U.S. Department of Agriculture
Agricultural Research Service - Pacific West Area NEGATIVE 


REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X


REPORTING 
PERIOD: 


OCTOBER 1, 
2015- MARCH 


31, 2016


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2016





		Instruction Sheet

		Agency Acronym

		RENAME BLANK FORM






Completing the OGE Form-1353


Saving the Workbook


-


-


-


Preparing Blank Report Forms for Each Sub-Agency  (if applicable)


-


-


-


Completing the General Information


Renaming the Spreadsheet Tabs


-


-


-


-


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.


Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission
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Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP







OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA


                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


1 2016


Agency Contact:
Andrew Tobin, 
Deputy Director


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Pantin-Jackswood, 
Mary


Second international 
Symposium on Avian 
Influenza


10/1/2016 Acapulco, MC Hotel & Meals x $786 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Ground Transp & 
Registration fee. x $550 


Research Vet Med Ofcr National Association of 
Poultry Science in Mexico 10/2/2016 09/30/2015-10/3/15 Air Transportation x $720 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Kapczynski, Darrell
Second international 
Sysmposium on Avian 
Influenza


10/1/2015 Acapulco, MC Hotel & Meals x $786 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Ground Transp & 
Registration fee. x $550 


Microbiologist National Association of 
Poultry Science in Mexico 10/2/2015 9/30/15-10/3/15 Air Transportation x $720 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


U.S. Department of Agriculture
Agricultural Research Service - Southeast Area (East) NEGATIVE 


REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X


REPORTING 
PERIOD: 


OCTOBER 1, 
2015- MARCH 


31, 2016


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2016


LOCATION


Asia Pacific Forum 
Pacific Rim Foundation 


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


tobin.andrew@oe.usda.gov


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


BENEFIT SOURCE


National Association of 
Poultry Science in 


Mexico, Dr. Miguel Angel 
Casillas  Durango  MX


BENEFIT SOURCE
National Association of 


Poultry Science in 
Mexico, Dr. Miguel Angel 


Casillas  Durango  MX


BENEFIT SOURCE


BENEFIT SOURCE







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


 


Zhuang, Hong


12th Cina Egg Science 
and Technology 
Conference and 2nd 
International Symposium 
of Egg Science and 
Technology


10/16/2015 Nanjing, Jiangsu 
Province, China Hotel x $400 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals x $600 


Research Food Tech. Nanjing Agricultural 
University 10/18/2015 10/01/15-10/2015 Air Transportation x $1,400 


3


TRAVEL DATE(S)


Nanji Agricultural 
University, National 


Engineering Research 
Center for Meat Quality 


and Safety Control, 
Nanjing, China, Prof. 


Jianhao Zhang, Nanjing 





		Instruction Sheet

		Agency Acronym

		RENAME BLANK FORM






Completing the OGE Form-1353


Saving the Workbook


-


-


-


Preparing Blank Report Forms for Each Sub-Agency  (if applicable)


-


-


-


Completing the General Information


Renaming the Spreadsheet Tabs


-


-


-


-


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.


Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission


Semiannual Report of Payment Accepted







Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP







OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA


                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


1 2016


Agency Contact:
Andrew Tobin, 
Deputy Director


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Soheila J. Maleki


Meeting - Food Allergy & 
Anaphylaxis Connection 
Team's Inaugural Food 
Industry & Research 
Summit 2015


10/5/2015 Las Vegas, NV Hotel X 400


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X 500


Research Chemist
Food Allergy & 
Anaphylaxis Connection 
Team


10/7/2015 10/05/02015-
10/07/2015


M&IE, Local 
Transportation X X 500


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Ruixiu Sui Meeting - Irrigation in 
Action 10/10/2015 Beijing, China Hotel X 1,800


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X 1,450


Research Agricultural 
Engineer


China Agricultural 
University 10/23/2015 10/06/2015-


10/23/2015 Meals X 1,536


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Georgia C. Eizenga Meeting - Review of 
Perennial Rice Research 10/11/2015 Kunming, P.R. China Meals X 50


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


U.S. Department of Agriculture
Agricultural Research Service - Southeast Area (W) NEGATIVE 


REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X


REPORTING 
PERIOD: 


OCTOBER 1, 
2015- MARCH 


31, 2016


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2016


3


LOCATION


Asia Pacific Forum 
Pacific Rim Foundation 


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


tobin.andrew@oe.usda.gov


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


BENEFIT SOURCE


Food Allergy & 
Anaphylaxis Connection 


Team


BENEFIT SOURCE


China Agricultural 
University


BENEFIT SOURCE


The Land Institute


BENEFIT SOURCE







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


 
TRAVELER TITLE EVENT SPONSOR ENDING DATE 


[MM/DD/YYYY]


Local 
Transportation, 
parking, fees


X 353


Research Geneticist 
(Plants) The Land Institute 10/16/2015 10/09/2015-10/17-


2015                            


3
TRAVEL DATE(S)





		Instruction Sheet

		Agency Acronym

		RENAME BLANK FORM






Completing the OGE Form-1353


Saving the Workbook


-


-


-


Preparing Blank Report Forms for Each Sub-Agency  (if applicable)


-


-


-


Completing the General Information


Renaming the Spreadsheet Tabs


-


-


-


-


Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission


Semiannual Report of Payment Accepted







Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP







OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA


                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


1 2016


Agency Contact:
Andrew Tobin, 
Deputy Director


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Sandra Hoffman Food Safety Australia 
New Zealand (FSANZ) 1/31/2016 Canaberra, Australia Hotel         X $1,750 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transporation         X $2,800 


Agricultural Economist Australian/New Zealand 
Government 2/5/2016 1/28/2016-2/12/2016                                    X $150 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Virgil Ball Organization for 
Economic Development 12/14/2015 Paris, France Hotel        X $680 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation        X $1,400 


Economist


Workshop on Measuring 
Environmentally Adjusted 
Agricultural Total Factor 
Productivity and Its 
Determinants


12/15/2015 12/12/2016-
12/17/2016 Meals        X $572 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Ronald Sands
Asian Pacific Intergrated 
Model International 
Workshop


11/13/2015 Tsukuba, Japan Hotel        X $450 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation        X $1,800 


BENEFIT SOURCE
Australian Agricultural 


and Research Economics 
Society for Food Safety 


BENEFIT SOURCE
Organization for 


Economic Development 
and Cooperation


BENEFIT SOURCE


National Institute for 
Environmental Studies


BENEFIT SOURCE


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


tobin.andrew@oe.usda.gov


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


Asia Pacific Forum 
Pacific Rim Foundation 


3


LOCATION


TRAVEL DATE(S)


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


U.S. Department of Agriculture
Economic Research Service NEGATIVE 


REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X


REPORTING 
PERIOD: 


OCTOBER 1, 
2015- MARCH 


31, 2016


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2016







 


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


Senior Economist National Institute for 
Environmental Studies 11/14/2015 11/11/2015-


11/15/2015 Meals        X $100 





		Instruction Sheet

		Agency Acronym

		RENAME BLANK FORM






Completing the OGE Form-1353


Saving the Workbook


-


-


-


Preparing Blank Report Forms for Each Sub-Agency  (if applicable)


-


-


-


Completing the General Information


Renaming the Spreadsheet Tabs


-


-


-


-


Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission


Semiannual Report of Payment Accepted







Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP







OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA


                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


2016


Agency Contact:
Andrew Tobin, 
Deputy Director


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Sarah McCaffrey


Provide keynote speech 
on "community and 
Wildland Fire" and 
participate in conference


10/12/2015 Pyeongchang, 
Republic of Korea Common Carrier


x


$2,000.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging x $1,278.00 


Research Forester Korea Forest Service 10/16/2015 10/10/15-10/17/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Constance I. Millar 


Mountains of Future Earth 
conference; Science 
Leadership Council 
Meeting, Mountain 
Research Initiative


10/4/2015 Perth, Scotland Common Carrier


x


$1,308.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Research Scientist Mountain Research 
Initiative 10/9/2015 9/24/15-10/10/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


David J. Nowak
39th Annual Parks & 
Grounds Spring Training 
Conference


2/17/2016 British Columbia, 
Canada Common Carrier x $1,000.00 


BENEFIT SOURCE


Korea Forest Service


BENEFIT SOURCE


Mountain Research 
Initiative


BENEFIT SOURCE


British Columbia 
Recreation & Parks 


Association


BENEFIT SOURCE


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


tobin.andrew@oe.usda.gov


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


Asia Pacific Forum 
Pacific Rim Foundation 


3


LOCATION


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


FOREST SERVICE 1353 TRAVEL REPORT
NEGATIVE 
REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X


REPORTING 
PERIOD: 


OCTOBER 1, 
2015- MARCH 


31, 2016


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2016







 


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Taxi/Shuttle x $100.00 


Project Leader
British Columbia 
Recreation & Parks 
Association


2/19/2016 2/17/16-2/19/16 Lodging x $322.00 


3
TRAVEL DATE(S)
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Completing the OGE Form-1353


Saving the Workbook


-
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Preparing Blank Report Forms for Each Sub-Agency  (if applicable)
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Completing the General Information


Renaming the Spreadsheet Tabs
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Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission


Semiannual Report of Payment Accepted







Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP







OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA


                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


2016


Agency Contact:
USDA, 
Headquarters, Office 
of Ethics


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Bruce G.Marcot
Workshop on 
BayesianNetwork 
Modeling


6/12/2016 Anchorage, Alaska Common Carrier x $1,260.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Taxi/Shuttle x $60.00 


Research Wildlife 
Biologist


International Association 
for Bear Research 6/12/2016 6/11/16-6/13/16 Lodging x $521.92 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Sarah McCaffrey IAWF Fire Behavior 
andFuels Conference 4/11/2016 Melbourne, Australia Common Carrier  


Lodging
x                 
x


$2,000.00  
$2,576.00


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals  x $618.00 


Research Social 
Scientist


Bushfire and National 
Hazards Cooperative 
Research Centre, the 
International Association 
of Wildland Fire


4/23/2016 4/8/16-4/24/16 Conference 
Registration x $550.00 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Tim Benedit 21st Annual 
LEPC/ASSE/MSSC 3/8/2016 Billings, MT Conference 


Registration x $275.00 


BENEFIT SOURCE


International Association 
for Bear Research 


BENEFIT SOURCE
Bushfire and National 
Hazards Cooperative 
Research Center  The 


BENEFIT SOURCE


Local Emergency 
Planning Committee


BENEFIT SOURCE


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


tobin.andrew@oe.usda.gov


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


Asia Pacific Forum 
Pacific Rim Foundation 


3


LOCATION


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


FOREST SERVICE 1353 TRAVEL REPORT
NEGATIVE 
REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X


REPORTING 
PERIOD: 


OCTOBER 1, 
2015- MARCH 


31, 2016


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2016







 


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Forest Safety Officer LocalEmergency Planning 
Committee 3/10/2016 3/8/16-3/10/16                            


3
TRAVEL DATE(S)
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Completing the OGE Form-1353


Saving the Workbook


-


-


-


Preparing Blank Report Forms for Each Sub-Agency  (if applicable)


-


-


-


Completing the General Information


Renaming the Spreadsheet Tabs


-


-


-


-


Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission


Semiannual Report of Payment Accepted







Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
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                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


2016


Agency Contact:
USDA, 
Headquarters, Office 
of Ethics


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Jeanne C. Chambers


Briefing of DOI/BLM 
Leadership on 
"Developing a 
Conservationa nd 
restoration Strategy for 
SO 336"


12/16/2015 Washington, D.C. Common Carrier   
Taxi/Shuttle x                 x $389.00     


$40.00


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging x $615.00 


Research Ecologist
Western Association of 
Fish and Wildlife 
Agencies


12/18/2015 12/16/15-12/19/15 Per Diem (at Gov 
Rate) x $242.00 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


                              


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


                           


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


                              


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


                           


BENEFIT SOURCE


Western Association of 
Fish and Wildlife 


Agencies


BENEFIT SOURCE


BENEFIT SOURCE


BENEFIT SOURCE


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


tobin.andrew@oe.usda.gov


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


Asia Pacific Forum 
Pacific Rim Foundation 


3


LOCATION


TRAVEL DATE(S)


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


FSA  326 TRAVEL REPORT
NEGATIVE 
REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X


REPORTING 
PERIOD: 


OCTOBER 1, 
2015- MARCH 


31, 2016


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2016





		Instruction Sheet

		Agency Acronym

		RENAME BLANK FORM






Completing the OGE Form-1353


Saving the Workbook


-


-


-


Preparing Blank Report Forms for Each Sub-Agency  (if applicable)


-


-


-


Completing the General Information


Renaming the Spreadsheet Tabs


-


-


-


-


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.


Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission


Semiannual Report of Payment Accepted







Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
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EOP
EX-IM BANK
FCA
FCC
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FEC
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FHFB
FLRA
FMC
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FRS
FRTIB
FTC
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IMLS
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IBWC
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MSPB
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NASA
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NCPC
NCUA
NEA
NEH
DMA
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NLRB
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NWTRB
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OMB
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                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


2016


Agency Contact:
USDA, 
Headquarters, Office 
of Ethics


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Pamela E. Starke-Reed
12th Nestle International 
Nutrition Symposium: 
Cognition & Brain Health


10/21/2015
Nestle Research 
Center, Lausanne 
Switzerland


Lodging
x


$675.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals x $194.00 


Deputy Administrator Nestle 10/23/2015 10/20/15-10/24/15 Taxi/Shuttle x $50.00 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Cletus Kurtzman
3rd International Conf. on 
Microbial Diversity "The 
Challenge of Complexity"


10/27/2015 Perugia, Italy Common Carrier    
Taxi/Shuttle


x                 
x


$1,095.00   
$140.00


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging x $1,337.00 


Research Microbiologist
Italian Society of Agrofood 
& environmental 
Microbiology


10/29/2015 10/23/15-10/31/15
Per Diem(at Gov 
Rate)                  
Registration


x                 
x


$798.00     
$270.00       


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


HEADQUARTERS  326 TRAVEL REPORT
NEGATIVE 
REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X


REPORTING 
PERIOD: 


OCTOBER 1, 
2015- MARCH 


31, 2016


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2016


LOCATION


Asia Pacific Forum 
Pacific Rim Foundation 


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


tobin.andrew@oe.usda.gov


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


BENEFIT SOURCE


Nestle


BENEFIT SOURCE


Italian Society of 
Agrofood & 


Environmental 
Microbiology


BENEFIT SOURCE


BENEFIT SOURCE







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


 


David Klurfeld


Expert panel of 20 
scientist from around the 
world to evaluate whether 
red and processed meat 
are carcinogenic.


10/6/2015 Lyon, France Common Carrier    
Taxi/Shuttle


x


x $1,320.00  
$98.00


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Lodging              
Meals                    x                   x $1,078.00  


$650.00
National Program 
Leader, Human 
Nutrition


International Agency for 
Researchon Cancer 10/13/2015 10/4/15-10/14/15 Mileage               


Parking x                 x $57.50      
$200.00


3


TRAVEL DATE(S)


International Agency for 
Research on Cancer
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		RENAME BLANK FORM






Completing the OGE Form-1353


Saving the Workbook


-


-


-


Preparing Blank Report Forms for Each Sub-Agency  (if applicable)


-


-


-


Completing the General Information


Renaming the Spreadsheet Tabs


-


-


-


-


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.


Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission


Semiannual Report of Payment Accepted







Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP







OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA


                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


2016


Agency Contact:
USDA, 
Headquarters, Office 
of Ethics


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Dr. Suelee Robbe-
Austerman


Seminar on Infectiouds 
Diseases, on tracking 
diseases of hih 
consequence using whole 
genome sequencing.


10/5/2015 Athens, Georgia
Common Carrier   
Taxi Shuttle         
Mileage


x                  
x x   


$675.00       
$50.00       
$42.00


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Lodging               
Misc.  x               x                 $182.00      


$5.00
aphis/nvsl/section head, 
dbl/mb


Dept. of Infectious 
Diseases, College of 10/5/2015 10/4/15-10/6/16 Per Diem (at Gov  


Rate                   
x                  
x


$92.00       
$36.00


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Cristobal Zepeda Ad hoc group 
onVaccination 11/17/2015 Paris, France Common Carrier  x $1,800.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Taxi/Shuttle x $100.00 


Veterinary Attache OIE (World Organization 
for Animal Health) 11/19/2015 11/15/15-11/20/15 Per Diem (at Gov  


Rate)                 x $2,134.50 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Cristobal Zepeda Ad hoc group on clasical 
Swine Fever 11/3/2015 Paris, France Common Carrier x $1,800.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Taxi/Shuttle x $100.00 


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


MARKETING  326 TRAVEL REPORT
NEGATIVE 
REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X


REPORTING 
PERIOD: 


OCTOBER 1, 
2015- MARCH 


31, 2016


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2016


3


LOCATION


TRAVEL DATE(S)


Asia Pacific Forum 
Pacific Rim Foundation 


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


tobin.andrew@oe.usda.gov


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


BENEFIT SOURCE


Department of Infectious 
Diseases College of 


Veterinary Medicine at 
the Univ. of GA.


BENEFIT SOURCE


OIE (World Organization 
for Animal Health)


BENEFIT SOURCE


OIE (World Organization 
for Animal Health)


BENEFIT SOURCE







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


 Veterinary Attache OIE (World Organization 
for Animal Health) 11/5/2015 11/1/15-11/6/15 Per Diem (at Gov 


Rate) x $2,134.50 





		Instruction Sheet

		Agency Acronym

		RENAME BLANK FORM






Completing the OGE Form-1353


Saving the Workbook


-


-


-


Preparing Blank Report Forms for Each Sub-Agency  (if applicable)


-


-


-


Completing the General Information


Renaming the Spreadsheet Tabs


-


-


-


-


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.


Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission


Semiannual Report of Payment Accepted







Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP







OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA


                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


1 2016


Agency Contact:
Andrew Tobin, 
Deputy Director


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


                              


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


                           


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


                              


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


                           


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


                              


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


                           


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


U.S. Department of Agriculture
National Agricultural Statistics Service NEGATIVE 


REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X X


REPORTING 
PERIOD: 


OCTOBER 1, 
2015- MARCH 


31, 2016


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2016


3


LOCATION


TRAVEL DATE(S)


Asia Pacific Forum 
Pacific Rim Foundation 


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


tobin.andrew@oe.usda.gov


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


BENEFIT SOURCE


BENEFIT SOURCE


BENEFIT SOURCE


BENEFIT SOURCE





		Instruction Sheet

		Agency Acronym

		RENAME BLANK FORM






Completing the OGE Form-1353


Saving the Workbook


-


-


-


Preparing Blank Report Forms for Each Sub-Agency  (if applicable)


-


-


-


Completing the General Information


Renaming the Spreadsheet Tabs


-


-


-


-


Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission


Semiannual Report of Payment Accepted







Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP







OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA


                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


1 2016


Agency Contact:
Andrew Tobin, 
Deputy Director


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Greg Crosby GPNM Second Regional 
Planning of the Caribbean 2/24/2016 Trinidad-Tobago                               


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $576 


National Program 
Leader UN Environment Program 2/25/2016 2/23-27/2016                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Greg Crosby
Global Nitrogen Cycling 
Project Steering 
Committee Meeting


2/3/2016 Manilla, Philippines Air Transportation X $1,386 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging X $895 


National Program 
Leader UN Environment Program 2/5/2016 1/31/2015-2/6-2016                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


                              


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


                           


BENEFIT SOURCE


UN Environment Program


BENEFIT SOURCE


UN Environment Program


BENEFIT SOURCE


BENEFIT SOURCE


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


tobin.andrew@oe.usda.gov


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


Asia Pacific Forum 
Pacific Rim Foundation 


3


LOCATION


TRAVEL DATE(S)


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


U.S. Department of Agriculture
National Institute of Food and Agriculture NEGATIVE 


REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X


REPORTING 
PERIOD: 


OCTOBER 1, 
2015- MARCH 


31, 2016


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2016





		Instruction Sheet

		Agency Acronym

		RENAME BLANK FORM






Completing the OGE Form-1353


Saving the Workbook


-


-


-


Preparing Blank Report Forms for Each Sub-Agency  (if applicable)


-


-


-


Completing the General Information


Renaming the Spreadsheet Tabs


-


-


-


-


Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission


Semiannual Report of Payment Accepted







Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP







OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA


                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


2016


Agency Contact:
Andrew Tobin, 
Deputy Director


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


William H.Durham


Souther Agricultural Cover 
Crops, Soil Health and 
Water Management 
Conference


10/28/2015 Arkansas State 
University Lodging x $283.89 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Regional Soil Health 
Specialist


Arkansas Association of 
Conservation Districts 10/29/2015 10/27/15-10/30/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


David W. Smith


International Symposium 
Entitle "Surface Soil, the 
Key for Human and 
Ecosystem"


11/23/2015 Seoul, South Korea Common Carrier  
Lodging x                x $1,500.00  


$1,200.00


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Taxi/Shuttle  x $100.00 


Deputy Chief, Soil 
Science and Resource 
Assessment


Soil Environment Center 
of the Korea 
Environmental Industry & 
Technology Institute, 
Ministry of Environment, 
Korea


11/27/2015 11/22/15-11/28/15 Meals x $550.00 


BENEFIT SOURCE


Arkansas Association of 
Conservation Districts


BENEFIT SOURCE


Research Center of 
Surface Soil Resource 


Inventory and Integration 
in South Korea


BENEFIT SOURCE


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


tobin.andrew@oe.usda.gov


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


Asia Pacific Forum 
Pacific Rim Foundation 


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


NATURAL RESOURCES CONSERVATION SERVICE
1353 TRAVEL REPORTS NEGATIVE 


REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X


REPORTING 
PERIOD: 


OCTOBER 1, 
2015- MARCH 


31, 2016


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2016







 


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Lisa F. Duriancik
Nutrient Management and 
Edge of Field Monitoring 
Conference


12/1/2015 Memphis, TN Registration Fee x $425.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


CEAP, Watersheds 
Component Leader


Soil and Water 
Conservation Society 12/3/2015 12/1/15-12/3/15                            


BENEFIT SOURCE


Soil and Water 
Conservation Society3


LOCATION


TRAVEL DATE(S)





		Instruction Sheet

		Agency Acronym

		RENAME BLANK FORM






Completing the OGE Form-1353


Saving the Workbook


-


-


-


Preparing Blank Report Forms for Each Sub-Agency  (if applicable)


-


-


-


Completing the General Information


Renaming the Spreadsheet Tabs


-


-


-


-


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.


Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission
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Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP







OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA


                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


2016


Agency Contact:
USDA, 
Headquarters, Office 
of Ethics


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Robert Tse


Rounodtable Conference 
on Information and 
Communications 
Technology


3/3/2016 Sonoma, California` Lodging x $287.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals x $227.00 


Community Planning 
and Development 
Specialist


California Foundation on 
the Environment and the 
Economy


3/4/2016 3/3/16-3/4/16                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Heather Handeland Deer Lodge Resource 
Assessment 3/7/2016 Deer Lodge, Montana Lodging x $158.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals x $102.00 


Area Specialist


Montana Department of 
Commerce and the 
Montana Economic 
Developers Association


3/8/2016 3/7/16-3/9/16                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


                              


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


RD 326 TRAVEL REPORT
NEGATIVE 
REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X


REPORTING 
PERIOD: 


OCTOBER 1, 
2015- MARCH 


31, 2016


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2016


3


LOCATION


TRAVEL DATE(S)


Asia Pacific Forum 
Pacific Rim Foundation 


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


tobin.andrew@oe.usda.gov


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


BENEFIT SOURCE


California Foundation on 
the Environment and the 


Economy


BENEFIT SOURCE


Travelodge, Powell 
County Senior Center


BENEFIT SOURCE


BENEFIT SOURCE







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


                            





		Instruction Sheet

		Agency Acronym

		RENAME BLANK FORM






Completing the OGE Form-1353


Saving the Workbook


-


-


-


Preparing Blank Report Forms for Each Sub-Agency  (if applicable)


-


-


-


Completing the General Information


Renaming the Spreadsheet Tabs


-


-


-


-


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.


Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission
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Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP







OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA


                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


2016


Agency Contact:
USDA, 
Headquarters, Office 
of Ethics


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Cynthia Parr
Biodiveity Information 
Standards Annual Meeting 
2015


9/25/2015 Nairobi-KENYA Common Carrier x $1,096.33 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Technical Information 
Specialist


African Conservation 
Center and TDWG 10/1/2015 9/19/15-10/2/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Lana Podielsky Program Training 11/6/2015 Tucson, AZ


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Property Utilization 
Specialist University of Arizona 11/20/2015 11/16/15-11/20/15                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Kristina Adams
Meeting the Information 
Requirements of the 
Animal Welfare Act


11/12/2015 Oklahoma City, OK Common Carrier x $252.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Taxi/Shuttlte x $50.00 


Technical Information 
Specialist


University of Oklahoma 
Health Sciences Center 11/12/2015 11/11/15-11/12/15 Lodging x $94.00 


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


SCIENCE 326 TRAVEL REPORT
NEGATIVE 
REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X


REPORTING 
PERIOD: 


OCTOBER 1, 
2015- MARCH 


31, 2016


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2016


3


LOCATION


TRAVEL DATE(S)


Asia Pacific Forum 
Pacific Rim Foundation 


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


tobin.andrew@oe.usda.gov


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


BENEFIT SOURCE


Biodiversity Information 
Standards


BENEFIT SOURCE


University of Arizona


BENEFIT SOURCE


University of Oklahoma 
Health Sciences Center


BENEFIT SOURCE
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